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Chapter 1

About AppsControl

AppsControl monitors and regulates changes to fields in Oracle Applications. It can
apply any of three “control types,” which subject field-value changes to increasing
degrees of review:

Audit: AppsControl tracks changes to fields, and presents a history of those
changes in reports. However, this control type allows users to make changes
freely.

Reason Code: AppsControl once again tracks field changes and presents change
history in reports. Moreover, when a user changes the value of a field, AppsControl
requires the user to enter a reason code and may send notification of the change
to another person or role (if a recipient of the notification has been specified).
No approval is required for the change to be made.

Approval: AppsControl again tracks changes to field values and presents change
history in reports. When a user changes the value of a field, AppsControl not
only requires the user to give a reason for the change, but also sends a request
for approval to a specified person or role. The approval must be accepted or
rejected, and the requesting user must acknowledge an approval. A change is
implemented only when it is approved and acknowledged.

AppsControl enforces rules — one for each field — to implement these controls.
You can use a form called the AppsControl Wizard to view these rules or to create
them manually. As an alternative to creating individual rules, you can upload already-
created rules from a “content spreadsheet,” and then use the Wizard to confirm that
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Chapter 1: About AppsControl

they have been uploaded correctly. Logical Apps provides more than 1,500 change-
control objects that you can tailor to your organization’s needs.

Moreover, you can create “subscribers” for each AppsControl rule; in other words,
you can define circumstances under which a control takes effect. For a given field you
can, for example, designate some users who are subject to change control and others
who are not. Or you can impose controls selectively for responsibilities, operating
units, or other entities. If no subscriber is defined for a rule, its control applies
universally.

Before You Start

Before you can use AppsControl to set up change control, make sure you have done
the following:

* In AppsFlow, define workflow roles to be used for notifications and approvals of
tield-value changes.

* In AppsAudit, validate that tables being audited contain primary keys.
e In AppsForm:
1 Turn on the Event Tracker for the forms you want to control.

2 Go to each form and navigate to all the fields, blocks, and tabs you want to
control.

3 Close the form.

2 User's Guide: AppsControl 6.5.6



Chapter 2

Creating Control Rules Manually

The AppsControl Wizard enables you to create new control rules. As an alternative,
you can upload already-created rules from a “content spreadsheet” (see Chapter 3).
In the Wizard, you can also view existing rules, either to modify them or to confirm
that content-spreadsheet rules have been uploaded correctly.

Starting AppsControl

To start AppsControl:
1 Log on to Oracle Applications.

2 Seclect the Logical Apps responsibility in the Oracle Applications list. (Ensure first
that the Logical Apps responsibility is available to you.)

3 A selection of Logical Apps applications appears. Click on the AppsControl
option.

Both the AppsControl Wizard and an AppsControl Find form appear on screen,

with the Find form initially active.

If you close AppsControl, you can restart it by double-clicking on the AppsControl
option in the LogicalApps Navigator that remains on your screen. (Or, click on the
option once, and then click on the Open button.)

User's Guide: AppsControl 6.5.6 3



Chapter 2: Creating Control Rules Manually

Making Selections in AppsControl

When you click in a text box to enter data, AppsControl presents a list icon to the
right of the box. It looks like an ellipsis:

Form Name

O

When you click on this icon, AppsControl opens a window in which you can pro-
duce a filterable list of values that may be entered in the text box. When appropriate,
the window also contains information related to each selectable item. For example,
in a list of form names (those used by underlying program code), each entry also
includes the corresponding user form name (the label that is visible to the user of an
Oracle Application) as well as the name of the application that uses the form.

Form Mame .

Find|%AKD

Qr on Mo k]

AKDA‘I‘I’RS Define Attributes Oracle Commaon Modules-Ak.

AKDFLOWE Flowe Warkbench Oracle Commaon Modules-Ak
ARDFLOWS Define Flows Oracle Commaon Modules-Ak.
AKDOBFKS Define Fareign Keys Cracle Common Modules-AK
AKDOBNYE ChjectWorkbench Oracle Common Modules-Ak,
AKDOBPKS Cefine Primary Keys Oracle Common Modules-Ak,
AKDPICKF Run Flows Oracle Common Modules-Ak
AKDQUERY Define Query Ohjects Oracle Comman Modules-AK
AKDREGMNS Define Regions Oratle Common Modules-AK
AKDRELOR Define LOV Relations Oracle Commaon Moduleg-AK.
AKDWATTR Assign Attribute Values COracle Common Modules-Ak.
T 3

To use this window:

1 Click in the Find box and type a string of characters for which AppsControl
should search. You can use the percent sign (%) to stand for any string of char-
acters. For example, the string 4KD would return all entries that begin with those
letters, while the string %.4KD would return all enters in which those letters
appear in any position. The percent sign alone would return all possible entries.

2 C(lick on the Find button. AppsControl returns a list of items that match your
search criteria.

3 Scroll through the list and click on the item you want.

Click on the OK button.

4 User's Guide: AppsControl 6.5.6



Chapter 2: Creating Control Rules Manually

Finding Control Rules

When you start AppsControl, a Find form is initially active:

= AppsControl Find

Agpplication Name || r

User Form Mame |

Form Mame |

Block Mare |

( Clear J ( e J ( Find )

If you intend to create new control rules, you can simply click on its New button; in
this case, the Wizard becomes the active form but displays no rule data.

However, you can also use the Find form to load existing control rules into the
AppsControl Wizard: To search for all rules, simply click on the Find button. Or, to
search for a selection of rules, supply values in any combination of the filtering fields:

* Application Name: From the list, select an Oracle Application containing fields
for which you want to view control rules. Or, leave the box blank to select all
applications.

* User Form Name: This box presents a list of the form names that are visible to
the user of an Oracle Application. Choose one containing fields for which you
want to view control rules. Or, leave the list box blank to select all forms.

* Form Name: This box presents a list of the form names that are used internally by
the system. If you’ve made a selection in the User Form Name box, AppsControl
automatically fills this box with the corresponding system form name. If you make
a selection in this box, it overrides the value in the User Form Name box —
AppsControl displays fields from the form identified by the system form name.
You can leave this box blank to select all forms.

¢ Block Name: From the list, select a form block containing fields for which you
want to view control rules. Or, leave the box empty to select all blocks in a form (if
you selected one in the Form Name or User Form Name box), or all blocks in all
forms (if you made no form-name selection), or all blocks in all applications (if
you made no application selection).

After entering values, click the Find button. Or, to discard the filtering selection you
have made and start over, click on the Clear button.

After being used, the Find form remains open in the background. To bring it to the
foreground and use it again, click on it (drag any other forms, such as the Wizard,
out of the way). If you close it, you can reopen it: Click on View in the menu bar,
then on Find in the View menu. Or, click on the Find icon, located second from the
left in the tool bar. (It looks like a flashlight.)
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Chapter 2: Creating Control Rules Manually

Creating Control Rules

To

create a control rule in the AppsControl Wizard, first create an empty row in the

upper grid of the form that appears when the Change Element tab is selected. If you
clicked on the New button in the Find form, you’ve already accomplished this. Other-
wise, use any of the following methods:

Ir

| [aPxvDMVD

2] [HOLD_FLAG_MIR

If the Change Element grid contains any empty rows, click in the first one.

Click on the New button, which is first on the left in the Oracle Applications
tool bar. (It looks like this: &)

Click on File in the Oracle Applications menu bar, then New in the File menu.

WAVR
Enabled

Block Name
[VNDR

Form Mame User Form Name Application Mame

|Payab|es

‘Emer Vendor

’
| \ | \ C
| \ | \ O
| \ | \ C

Colurnn Tranglations Rules

Change Details

Field Name User Field MName Control Type WorkFlow Role

|Supp|ier - PO Purchase Order Hol ‘ Reason Code 'HSYSADMIN |Genera|

Reason Type

|

Cnmmenls|

[ i |

( Generate Current Rule ‘ I Generate Selected Rules )

Selecting a Block of Controllable Fields

In the empty row you’ve created (in the upper grid under the Change Element tab),
specify a block of fields in an Oracle Applications form. Enter values in these fields:

Form Name: This box accepts form names that are used internally by the system.
Select one containing fields for which you want to create control rules. When you
make a selection in the Form Name box, AppsControl automatically inserts cor-
responding entries in the User Form Name and Application Name boxes.

User Form Name: This box accepts user form names (those visible to the user of
an Oracle Application). If you made a selection in the Form Name box, AppsControl
inserted the correct User Form Name here. If you select a User Form Name first,
AppsControl inserts an appropriate value for Form Name, but not Application Name.

Application Name: This box accepts the name of the Oracle Application that
uses the form you specified in the previous two boxes. If you began by making a
selection in the Form Name box, AppsControl has inserted the correct Applica-
tion Name here. If you began by making a User Form Name selection, you can
type an application name here. Or, click in the Form Name box, then in any
other box in the row to have AppsControl generate the appropriate value.

User's Guide: AppsControl 6.5.6



Chapter 2: Creating Control Rules Manually

* Block Name: This box accepts the names of field blocks that appear in the form
you have selected. Choose the block that contains fields for which you want to
create control rules. You must use the Event Tracker in AppsForm before per-
forming this step. Otherwise, no block values appear in the Block Name box.

Note

Z You can type values into the User Form Name, Application Name, and
Block Name boxes. However, use caution; if you enter an incorrect value,
change tracking is not propetly enabled.

¢ WVR Enabled: You must select the check box if you have chosen a form (in the
Form Name field) associated with a When Validate Record event. You must clear
the check box if the form is not. Generally, AppsControl selects or clears the check
box appropriately for the chosen form, and you should accept the default setting.

If a form is associated with a When Validate Record event and the check box is
selected, AppsControl applies the control rules you create when a user attempts
to save changes to any controlled fields on the form.

If the form is not associated with a When Validate Record event and the check
box is cleared, AppsControl write-protects the fields for which you create Reason
Code or Approval control rules. The user can then modify each field value in the
AppsControl Change Request form (see page 19).

Creating Control Rules for Fields in the Selected Block

In the lower grid of the AppsControl Wizard, select individual fields and enter
control-rule values for them. In each row of this grid, you can select values for one
of the fields in the block you specified in the upper grid.

1 Ensure that the Change Details tab is selected, then enter these values:

* TField Name: Enter the name by which the underlying code calls the field you
want to control. Select from the list (items are available if you have used the
Event Tracker in AppsForm to capture them; see page 2), or type a value.

*  User Field Name: AppsControl automatically selects a user field name (the
label visible to the user of an Oracle Application) corresponding to the Field
Name you selected in the previous box. You can replace it with another value.
This name appears in the Change Request form and in notifications.

¢ Control Type: Select the level of control you want to apply to the field —
Audit, Reason Code, or Approval. For control-type definitions, see page 1.

¢  WorkFlow Role: Select the person or role who reviews changes made to the
field. For the Approval control type, you must enter a WorkFlow Role value;
it designates the person who approves changes. For the Reason Code control
type, you may enter a WorkFlow Role value to designate a person notified of
the change. WorkFlow Role does not apply for the Audit control type.

* Reason Type: Select the name for a group of reason codes (see “Creating Rea-
son Codes” on page 9). A user who changes the Oracle Applications field can
apply any reason code belonging to the group you select here. You must select

User's Guide: AppsControl 6.5.6 7



Chapter 2: Creating Control Rules Manually

a reason type if you selected the Approval or Reason Code control type; a
Reason Type selection does not apply if you selected the Audit control type.

Enable: To activate a change-control rule for a field, select the check box to
the right if its row; clear the check box to turn off the rule. Or, select or clear
the All check box, at the upper right of the Change Details panel, to enable
or disable all rules currently displayed in the panel.

Comments: Type a comment that explains the business risk addressed by the
change-control rule you are creating.

2 C(lick on the Column Translations tab.

Under User Field Name, AppsControl supplies the display name of the field
you want to control (it’s a copy of the value in the User Field Name box of
the Change Details tab). You cannot change this value.

Under Column Name, select the name of the database column that corre-
sponds to the value entered in User Field Name — the column that stores
data entered in the field.

Using the Translations Tab to Select Record Identifiers

In the Translations tab, you associate change-controlled fields with other fields that
identify the individual record to which changes apply. The values you select here are
valid for any fields in the block you selected under the Change Element tab.

For example, if you were to apply change control to a field that provides information
about vendors, you would use the Translations tab to specify a field or fields that
identify a vendor whose record has changed.

ARRSC izard
Change Element .MHM
—————— Record Identifiers
Dizplay Prompt Dizplay Column (Elock.Field)
[Vendor Name [VNDR.VENDOR_NAME_MIR
Table Name |P0_VENDORS Import Primary Keys
Primary Keys
Prirmary Key Colurns Form Field (Block.Field)
= | [venboRr_ip \VNDR.VENDOR_ID

Click on the Translations tab and fill in the following values.

Display Prompt: Type a name for the record-identifying field. (You may
choose any name that has meaning for you, although it’s typical to apply the
user field name that’s already established for the field.)

User's Guide: AppsControl 6.5.6



Chapter 2: Creating Control Rules Manually

When a user changes a controlled field, he may (depending on the control
type applied to the field) complete a Change Request form (see page 17). The
Display Prompt value appears as a label in that form. (In the illustration on
page 18, it’s the label Iendor Name near the top of the Change Request form.)

Display Column (Block.Field): Select the name of the field you want to use
for record identification. Use the format BLOCK.FIELD, in which BLOCK is the
name by which underlying code recognizes the form block that contains the
field you want to use, and FIELD is the name by which underlying code calls
the field you want. The block does not have to match the block you specified
under the Change Element tab.

Table Name: Select the name of the database table that corresponds to the
block you specified under the Change Element tab.

Primary Keys: Click on the Import Primary Keys button. Under the label
Primary Key Columns, AppsControl lists the names of the primary keys for the
table you selected in the Table Name box. You cannot change these values.

Form Field: For each database column name entered under the Primary Key
Columns label, type the name of the corresponding form field. Once again,
use the format BLOCK.FIELD, in which BLOCK is the name by which underly-
ing code recognizes the form block that contains the field, and FIELD is the
name by which underlying code calls the field you want.

Creating Reason Codes

When a field is assigned the Reason Code or Approval control type, a user who
makes a change to the field must use a Change Request form to select a reason for
the change. Each reason is one in a group of codes assigned to the field.

To create both reason codes and the groups to which they belong:

1 Click on Tools in the Oracle Applications menu bar, then on AppsControl
Reason Code in the Tools menu. An AppsControl Reason Code form appears:

= AppsContral Reason Cade [ri el e e e e e e e e e ool o ] X
Reason Type W Description |Reasons for field changes that may apply broa
R Coidle
Enabled
Reason Code Reason Description Flag
= l |Curret:(iun |A currently entered value is erroneous. I
Bl | =
| | =
l | 0
= Ul | =

2 Create the reason-code group. Fill in these boxes:
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Chapter 2: Creating Control Rules Manually

3 Create reason codes that belong to this group of codes. Devote each row of the
Reason Code grid to one code. Fill in these boxes:

¢ Reason Code: Type a unique name for a reason code. This will appear in the
list of values in the AppsControl Change Request form.

¢ Reason Description: Type a description of the code you have created.

* Enabled Flag: Select the checkbox to put the reason code into effect. Clear
the checkbox to disable the reason code. When a code is disabled, it is not
available for selection by a user who makes a change to a controlled field
even if its group of rules has been assigned to that field.

4 Save the reason codes: Select File from the Oracle Applications Menu bar, then
Save from the File menu.

5 Close the AppsControl Reason Code form: Click on the X symbol in its upper
right corner.

To open an already existing group so that you can modify or add to its reason codes:

1 Open the Reason Code form: Click on Tools in the Oracle Applications menu
bar, then on AppsControl Reason Code in the Tools menu.

2 C(lick on View in the menu bar, then on Query by Example in the View menu,
and then on Enter in the Query submenu.

3 The Reason Type and Description boxes in the Reason Code form turn blue. In
these boxes, type enough information to identify uniquely the group you want to
open. (Typically, the name of the group in the Reason Type box is sufficient.)

4 Click on View in the menu bar, then on Query by Example in the View menu,
and then on Run in the Query submenu.

Finishing the Control-Rule Generation

When you complete the foregoing configuration tasks for any number of fields, you
can generate rules that implement your work, either one at a time or collectively. To
generate a single rule:

1 Click on either the Change Details or Rules tab in the bottom grid of the Change
FElement form.

2 C(lick on the row for which you want to generate a rule. A rectangle to its left
turns blue.

3 C(Click on the Generate Current Rule button.
To generate any number of rules at once:
1 Click on the Rules tab in the bottom grid of the Change Element form.

2 Sclect the Generate check box for each of the rows for which you want to gener-
ate rules. Or, select the check box at the upper right of the Rules panel to choose
all rows displayed in the panel. (If you clear that check box, you deselect all rows
from rule generation.)

10 User's Guide: AppsControl 6.5.6



Chapter 2: Creating Control Rules Manually

3 Click on the Generate Selected Rules button to create rules for all the rows you
have selected.

Change Details Colurnn Translations

.
User Field Mame Rule Mame Process Marne Audit Generate

[ [VAT Tax Expense/Revenue Account LA_CC_ARXSUVAT.AR_VAT_1/AppsControl Approval [LA_AC_ARXSUVAT 7]
| [WAT Tax Hon Receverable Tax Account |[LA_CC_ARXSUVAT AR_VAT_1/AppsContral Approval [LA_AC_ARXSUVAT =]
|VAT Tax Description [LA_CC_ARXSUVAT-AR_VAT _1/AppsContral Approval [La_AC_ARXSUVAT rd
| [WAT Tax Displayed Flag ILA_CC_ARXSUVAT-AR_VAT _1/AppsControl Approval [LA_AC_ARXSUVAT )
|VAT Tax Enabled Flag [LA_CC_ARXSUVAT-AR_VAT _1/AppsContral Approval [LA_AC_ARXSUVAT rd

( Generate Current Rule ‘ I Generate Selected Rules J

Once you have generated rules, click on Tools in the Oracle Applications menu bar,
then on AppsAudit Compile Audit Objects in the Tools menu. Verify that the process
has run successfully under View/Reports.

The rules tab provides information about rules that have been generated, which varies
according to control type:

¢ The Rule Name field displays a name for the rule, but is populated only for the
Reason Code and Approval control types.

e The Process Name field identifies the workflow process that sends notification
of a change to a reviewer. It’s always populated for an Approval rule, is populated
for a Reason Code rule only if a value for that rule is entered in the WorkFlow
Role field of the Change Details tab, and is never populated for an Audit rule.

e The Audit field displays the name of an “audit group” that applies to the con-
trolled field. (AppsControl “directs” AppsAudit to perform auditing at the data-
base level. The controlled field corresponds to a database column; the column
exists in a database table; and to track changes to columns in a table, AppsAudit
places the table in an audit group.) This field is populated for all three control

types.

Defining Subscribers for AppsControl Rules

Once a Reason Code or Approval rule is created, you can open the rule in

Logical Apps AppsForm to create “subscribers” for it. A subscriber is a filter that
selects users, responsibilities, or other entities to which a rule applies. Thus, you can
enforce change controls selectively — for example specifying that the control
defined for a field be implemented for some users, but not for others.

As you create subscribers, you can filter on these entities: responsibility, profile,
operating unit, inventory organization, user; the value entered in a field or returned
by a database function or SQL statement; or a subscriber list (itself a selection of
users, responsibilities, or other entities).

User's Guide: AppsControl 6.5.6 11
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12

To define a subscriber for an AppsControl Rule:

1 After you have generated rules (page 10), locate the AppsControl rule for which
you want to define subscribers:

a

In the upper grid of the AppsControl Wizard, select the row corresponding
to the block that contains the controlled field.

In the lower grid of the AppsControl wizard, click on the Rules tab and then
select the row corresponding to the field itself.

In the Rules panel, navigate to the Rule Name field. Ensure that the entire
rule name is selected, and then press Ctrl+C to copy it.

2 Close AppsControl (click on the X symbol in the upper right corner of the
AppsControl Wizard). In the LogicalApps Navigator, double-click on AppsRules.
In the AppsRules form, ensure that the AppsForm tab is selected.

3 Query for the AppsControl rule:

a
b

C

Press the F11 key.

Ensure that the cursor is located in the Rule Name field, and press Ctrl+V to
copy the name of the AppsControl rule into the Rule Name field.

Press Ctrl+F11.

4 Click on the Rule Subscribers button. The Subscribers form opens; in it, create
and save the subscriber for the rule. For complete information on defining sub-
scribers, see “Creating Subscribers” in the AppsForm User’s Guide.

4

Note

Within the system administrator responsibility, a System Profile Values form
enables users to configure profiles, each at several levels: site, application,
responsibility, user, server, or organization. Each of these levels constitutes a
“field” (and the value entered for an individual profile is a “field instance”),
so that an AppsControl rule to control profile-value changes at any of these
levels affects all profiles at that level.

If you need to control changes to the values of individual profiles (while
leaving others uncontrolled), create an AppsControl rule for the appropriate
field (for example, PROFILE_VALUES.SITES_VISIBLE_VALUE for site-level
profiles). Then create subscribers for the rule, in which the Filter Type is
Data, the Filter Name is the name of the field that holds profile names
(PROFILE_VALUES.USER_PROFILE_OPTION_NAME), the Operator is Equal,
and the Dependent Value is the name of the profile you want to control.
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Uploading or Migrating Control Rules

AppsControl includes a “content spreadsheet,” which contains more than 1,500
fully configured change-control rules. Your Professional Services representative re-
views this spreadsheet with you to determine which rules are appropriate for your site.

Whether you upload rules from a content spreadsheet or create them individually in
the AppsControl Wizard, you can “migrate” them — copy them from one Oracle
Applications instance to another.

In either case, you make use of concurrent requests you launch from the LogicalApps
Navigator or from AppsControl. To run a concurrent request from the Navigator:

1
2

Click on View in the menu bar, then on Requests in the View menu.

A Find Requests form opens. Click on its Submit a New Request button. In the
Submit a New Request dialog, click on Single Request and then on the OK button.

A Submit Request form opens. In its Name list of values, select the concurrent
request you want.

A Parameters form appears. Supply parameter values and click on the OK button.
(Parameters vary by request; some are required and others optional. See the de-
scription of each request for a discussion of its parameters.)

In the Submit Request form, click on the Submit button. At the next prompt, note
the request number, and then click on No to return to the Find Requests form.

If you choose to view a request log, click on the Specific Requests button. Type
the ID number for your request in the Request ID field, and click on the Find
button. A Requests form opens; click on its View Log button.

User's Guide: AppsControl 6.5.6 13



Chapter 3: Uploading or Migrating Control Rules

Uploading Rules from a Content Spreadsheet

To upload rules from a content spreadsheet, first review and prepare them:

1 Review the spreadsheet with your Professional Services team member. Select the
rules that target fields for which you want to implement controls. Type the letter Y
in the Upload column for each of these rules.

2 Create a flat file containing the rules you’ve selected: From the Tools menu in
Excel, select the Create CSV for AppsControl option. Specify the destination for
the CSV file and select the Save button.

3 A control total message displays the number of rules written. To verify the com-
pleteness of your upload file, compare this with the number of rows you selected.

To upload the file you’ve prepared:

1 FTP the CSV file to the /ust/tmp UNIX directory of the instance in which the
rules are to be used.

2 Open the Navigator in the Logical Apps responsibility and run the LA AppsControl
Data Load concurrent request. Supply the following parameters:

* File Name: Type in the name of the CSV file to be loaded. This parameter is
mandatory.

* File Location: Type in the UNIX path to the file to be loaded. This parame-
ter is mandatory.

¢  Debug Mode: Select Yes to enable debug functionality for the load, or No to
disable the functionality.

* Load Data: Select Yes if the data is to be loaded into the AppsControl rule
repository. Select No if this is a data validation run only.

3  Open AppsControl (page 3). Click on Tools in the menu bar, then on AppsAudit
Compile Audit Objects in the Tools menu. A pop-up note informs you of a con-
current request ID number. Click on the OK button to clear the message.

Migrating AppsControl Rules

The method you use to copy AppsControl rules from one instance to another depends
upon whether (and if so, how) you have modified them in the source instance:

¢ If you have uploaded rules from a content spreadsheet to a source instance and
have neither changed them nor added rules to them, simply upload the same rules
from the content spreadsheet to the destination instance.

¢ If you have uploaded rules from a content spreadsheet, added subscribers to some
or all of them, but made no other changes, upload the same rules from the con-
tent spreadsheet to the destination instance. Then, open AppsForm on the source
instance and use its Migration Utility to migrate each of the AppsControl rules to
which you have added subscribers. For information on using this utility, see
“AppsForm Migration” in the AppsEorm User's Guide.
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e If you have used the AppsControl Wizard either to create rules or to modify
rules uploaded from a content spreadsheet, open the Logical Apps Navigator on
the source instance and run a concurrent request called LA AppsControl Data
Export. This request takes the following parameters:

— File Location: Type in the UNIX path to the export file you are creating.
This parameter is mandatory.

— File Name: Type a name for the export file you are creating. This parameter
is mandatory.

— Application: Select one Oracle Application to export rules associated with
that application, or leave the parameter blank to export rules associated with
all applications.

— Form: This parameter is available only if you have made a selection for the
Application parameter. Select a form used by the application to export only
control rules associated with that form, or leave the parameter blank to export
rules associated with all forms.

— Block: This parameter is available only if you have made a selection for the
Form parameter. Choose a block that belongs to the selected form to export
only control rules associated with that block, or leave the parameter blank to
export rules associated with all blocks.

— Table: This parameter becomes available only if you have made a selection
for the Block parameter. Choose the database table that corresponds to the
selected block, or leave the parameter blank.

— Field: This parameter becomes available only if you have made a selection for
the Table parameter. Choose a form field that belongs to the selected block
(and for which data is stored in the selected table) to export only the single

control rule for that field, or leave the parameter blank to export control
rules for all fields on the block.

— Control Type: Select one of the three control types to export only rules that
implement that control type, or leave the parameter blank to export all types
of rules.

— Enabled Flag: Select Yes to export only those rules for which the Enabled
Flag check box (page 8) is checked; Select No to export only those rules for
which the Enabled Flag check box is cleared; or leave the parameter blank to
export rules configured in both ways.

Then, use the file you create to run the LA AppsControl Data Load concurrent
request on the destination instance. (Follow the procedure described in “Upload-
ing Rules from a Content Spreadsheet,” page 14.)

 Finally, if you’ve created or modified rules in the AppsControl Wizard and added
subscribers to one or more of them, combine the directions in the previous two
bullet points. Run LA AppsControl Data Export on the source instance; use the
resulting file to run LA AppsControl Data LLoad on the destination instance; and
then use the AppsForm Migration Utility to migrate all AppsControl rules with
subscribers from the source instance to the destination instance.
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Applying Changes to Controlled Fields

When you enter or modify data in an Oracle Applications field that is subject to change
control, the process you follow depends on the control type assigned to the field.

Audit

If a field is under Audit change control, any change you make is captured and avail-
able for reporting. However, you need not select a reason code or obtain an approval,
so there is no change to your ordinary procedure. Fields under Audit change control
are not distinguished visually from fields that are not subject to change control.

Reason Code or Approval

In most cases, a field subject to Reason Code or Approval change control appears in
bright yellow on its Oracle Applications form. (On some forms, however, certain con-
trolled fields are not distinctively colored; this depends on Oracle form functionality.)

AppsControl may handle changes to the values of these fields in either of two ways,
depending on whether the fields exist on a form associated with a When Validate Record
event, and therefore whether the WVR Enabled check box in the AppsControl Wiz-
ard is selected for each block of the form (see page 7).

e If so, AppsControl allows the user to make changes to the fields, but imposes the
controls when the user attempts to save the changes. The user would open a Change
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Request form to offer reasons, and if appropriate to begin the approval process,
for all the changed fields at once.

If not, AppsControl write-protects the controlled fields, and a user cannot make

changes to them directly. For each field, the user would instead open the Change
Request form and enter the new field value there — as well as offer a reason for

the change and, if appropriate, initiate the approval process. In this case, the user
can modify only one field at a time in the Change Request form.

Change Control with WVR Enabled

To change the values of controlled fields on a form associated with the When Vali-
date Record event:

1
2

Enter new values in any number of controlled fields as you ordinarily would.

Save the changes: Click on file in the menu bar, and then Save in the File menu.
Or, click on the Save button, located fourth from the left in the tool bar (it looks
like a disk).

The following message appears. Click on the OK button to clear it.

“alue for one or more fields that is under Change Control has changed.
ReasonfApproval is needed to save the changes. Go to Actions Menu to

request for Change Approval.

Click on Actions in the Oracle Applications menu bar, then on AppsControl
Change Request in the Actions menu. The following form appears:

“endor Mame [3M Health Care

Change Element

User Field Mame Original Yalue Mew Value Reazon Reguest Date  Requested By — Status
= |[Supplier - Invoice Am | [1234500 (Correction  [20.APR2005 [SYSADMIN  [APPROVEL
| J[Supplier - Tax Registr | [1234 \ [ [27.APR2005 |[SYSADMIN  [PENDING
el \ | \ \ \ |
\ \ | \ \ \ |
\ | \ \ \ |

N ‘

Cormments ‘

Dane ( Cancel ( Reject

The form devotes a row to each of the changes you are making (and, in other
rows, displays information on changes made in prior sessions). In each row that
applies to a new change, most of the fields provide information but do not accept
input. These include User Field Name, Original Value, New Value, Request Date,
Requested By, and Status.

In each row that applies to a new change, click in the Reason field to select a
reason from a list of those configured for the field.

In the Comments text box, you may add any comments you deem appropriate.
These comments appear on the Change History Report (see page 25). The Com-
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ments text box displays information specific to whatever row you’ve selected in
the grid — it presents an already-recorded comment for an old change or, for a
new change, it clears so that a new comment may be entered.

7 Click on the Done button.

Change Control with WVR Disabled

To change the values of controlled fields on a form that is not associated with the
When Validate Record event:

1 Select (click on) a controlled field whose value you want to change. Note that if
you try to enter a value in the field, the status bar near the bottom of the screen
displays the message “Field is protected against update.”

2 With the field selected, click on Actions in the menu bar, and then on AppsControl
Change Request in the Actions menu.

e If you are attempting to modify a list of values, its Find form opens, present-
ing a selection of entries appropriate for the field. Click on one and on the
OK button. The Change Request form then opens and displays your selection
in the New Value field.

* If you are attempting to modify a data-entry field, the Change Request form
opens immediately, and the New Value field is blank. Type the value you want
in the New Value field.

In either case, some fields provide information but do not accept input. These
include User Field Name, Original Value, Request Date, Requested By, and Status.

3 Click in the Reason field to select a reason from a list of those configured for the

tield.

In the Comments text box, you may add any comment you deem appropriate.
5 Click on the Done button.

Repeat this process for each controlled field you want to change. When you fin-
ish making changes, save your work: Click on file in the menu bar, and then Save
in the File menu. Or, click on the Save button, located fourth from the left in the
tool bar (it looks like a disk).

Completing the Approval Process

If you are working with a field assigned the Reason Code control type, the process of
changing the field value is complete. (You can still undo such a change: reopen the
Change Request form, select the row that represents the change, and click on the
Reject button.)

If, however, the field was assigned the Approval control type, the status of the change
remains pending (as shown in the Status column of the Change Request form), and
you cannot make further changes to the field until the pending change is approved
or rejected. An approval decision involves the following additional steps:
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1 When you close the Change Request form, the following message appears,
informing you that the approval workflow process has begun. Click the OK
button to clear it.

Mote

Process Launched Successfully.
Generated Process keys : 102081

2 The individual (or workflow role) assigned to approve the change receives a noti-
fication that the change is pending.

Select Notification(s) and ... _Open )| Reassign )
Salect Al J Select Mone Mext 25 =
Salect From Ilﬂ V. 3 ubj I!ilml v IHuu v |

27.Apr2005

[T SYSADMIN

—

LAAF Anproval

3 The user clicks on the notification to open it, review the information, and
optionally add a comment:

- |
ORACLE
Workflow

—

The User SYSADMIN has requested change on "Supplier - Tax Registration Number” from " " ta "1234" on 27-APR-05
(Approve ) [ Reject ) [ Reassign ) ( Reauest Infarmation )

Beban bo Portsl Logod Pretmerces Help

From SYSADMIN
To SYSADMIN
Sent 27 -Apr J00% 09:38:34
Metification 1D 406659

Change Details

Parent Record Type * Supplier

Farent Record | 3M Health Care

Child Record Type

Child Recond

Field - Suppher - Tax Registralion Number
Qld Value

Mewi Value - 1234

Reasan Coda - Comection

Comments

Matification History
Seq|Performear | Start Date End Date Action Commaant
1 SYSADMIN | 27-APR-2005 DD 38 33 | 27-APR-2005 023833 |Submitted
Response
COMMENT =l
|
Estum to Warklist

Approve ) [ Relect ) Reassign ) [ Reauest Information )

T Display next notificalion sfer my response

Betum to Podtal | Logost | Preferences | Help
Coppright 2003 Oracks Corporadion. Al rights seserved Privsr Slulsmyat

4 The user also clicks one of the following buttons:

e Approve: A notification of the approval is sent to the original requester, who
must acknowledge the acceptance.

* Reject: The change cannot be made.
¢ Reassign: The decision to approve or reject is reassigned to another user

In the case of approval, the field-value change is not made until the original requester
acknowledges the approval. This user opens the form on which the field appears,
selects the field, and receives a dialog box offering the option to update the field. If
the requester clicks on the Yes button, the field is updated. If the user selects the No
button, the change is postponed, but not cancelled. Eventually the requester must
select the Yes button because the change has been approved.
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Viewing Reports

AppsControl includes three reports, which allow you and the auditors to understand
what’s happening with the fields you have under control.

¢ The Logical Apps AppsControl Change History Report shows you the history of
changes to fields you have under change control.

e The Logical Apps AppsControl Control Listing Report shows you all the objects
you have under control, first by application and then by responsibility.

¢ The Logical Apps AppsControl Approver Performance Report provides statistics
about the numbers of approvals, rejections, and pending decisions, and the time
required for decisions, for each person authorized to approve changes.

Running Reports

To run any of the reports:

1 With the Logical Apps Navigator open, click on View in the Oracle Applications
menu bar, then on Requests on the View menu. The Find Requests form appears
(as shown at the top of the next page).
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T My Completed Requests

T My Requests In Progress

~ " Specific Reques

Regquest ID

Name |

Date Submitted
Date Completed

Status | |
Phasze

Requestar

W Include Reguest Set Stages in Query
Order By |Request 1D v|

( Submit a New Request. .. jl ( Clear | I Find )

Click the Submit a New Request button. At the prompt, select Single Request
and click OK. The Submit Request form appears.

~— Run this Request...

Copy...

MNarne |La AppsControl Control Listing Report(Text) |_

Parameters

Language |American English
Languages...

— At these Times...
Run the Job |As Soon as Possible ( Schedule. ..

~— Upon Completi

v Save all Output Files

Notify | Options. ..

Print to |nuprint

Help (B) ( Submit | [ Cancel )

In the Name list, locate and select the name of the report you want to view. Click
on the OK button.

The Parameters form appears. To filter the entries in a report, select values for
any number of parameters; or, to include all possible entries in a report, leave all
the parameter list boxes blank. Parameters vary from one report to another (see
the description of each report for a discussion of its parameters).

In the Submit Request form, click on the Submit button. At the next prompt,
make a note of the request number; then click Yes to run another report or No
to return to the Find Requests form.

To see your report and its progress, click the My Requests in Progress radio
button and then the Find button. Or click the Specific Reports button, type the
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request number for your report in the Request ID field, and click the Find
button.

A Requests form shows the status of your request. When it informs you that the
report is completed, click on the View Output button. The report appears. (From
this form, you can also click the Submit a New Request button to begin the proc-
ess of generating another report.)

( Refresh Data | [ Find Reguests /I ( Submit & New Reguest... /I
Reguest ID Parent
) Mame | Phase Status Pararmeters
l|p1?33l]4 |LA AppsControl Approval| |Comp|eted |Norma| |0racle Bills of Material, ,,,,,,,, =
U | | | | |
| | | | | |
U | | | | |
U | | | | |
U | | | | |
U | | | | |
| | | | | |
| | | | | |
| | | | | | <
( Hald Reguest [ Wiew Details... J ( Wiew Dutput J
( Cancel Reguest [ Diagnostics ) ( Wiew Log... )

Control Listing Report

The Logical Apps AppsControl Control Listing Report shows you all the objects you
have under control. As you generate the report, you can select the following parameters:

Application: Select an application name from the list or leave the box blank. If
you select a name, the report lists only controlled fields that apply to the applica-
tion you choose. If you leave the box blank, the report lists controlled fields for
all applications.

Form Name: Select the internal name for a form or leave the box blank. (You
can make a selection in this box only if you have also made a selection in the
Application box.) If you select a form, the report lists only controlled fields that
appear in that form. If you leave the box blank, the report lists controlled fields
for all forms.

Approver: Select the name of a person or group with authority to approve or
reject field-value changes, and the report lists controlled fields subject to that
approver’s judgment. Or leave the box blank to list controlled fields that apply to
all approvers.

Change Type: Select Audit, Reason Code, or Approval to limit the report to fields
of the control type you select. Or leave the box blank to include all control types.
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Status: Select from the list to have the report list fields whose controls have been

Disabled or Enabled, or leave the box blank to have the report include both

types.
The Control Listing Report looks like this:
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Change History Report

The Logical Apps AppsControl Change History Report shows the history of changes
for fields under change control. As you generate the report, you can select the follow-
ing parameters:

Application: Select an application name from the list or leave the box blank. If
you select a name, the report lists only changes that apply to the application you
choose. If you leave the box blank, the report lists changes for all applications.

Form Name: Select the internal name for a form or leave the box blank. (You
can make a selection in this box only if you have also made a selection in the
Application box.) If you select a form, the report lists only changes that appear in
that form. If you leave the box blank, the report lists changes for all forms.

Field Name: Select the name for a field or leave the box blank. (You can make a
selection in this box only if you have also made selections in the Application and
User Form Name boxes.) If you select a field, the report lists only changes for
that field. If you leave the box blank, the report lists changes for all fields.

Record Identifier 1: Select the name of a field configured as a record identifier
(see page 8) to have the report include changes associated with that identifier. Or
leave the box blank to include changes associated with all identifiers.

Record Identifier 2: Select the name of a second field configured as a record
identifier (see page 8) to have the report include changes associated with that
identifier. Or leave the box blank to include changes associated with all
identifiers.

Approve Status: Select Approved, Rejected, Pending, or Closed to have the
report include only field-value changes at the status you select. Or leave the box
blank to include field-value changes at all statuses.

Requested By: Select the name of a user to have the report include field-value
change requests made by that user, or leave the box blank to have the report
include change requests made by all users.

Approved By: Select the name of a person or group with authority to approve
field-value changes to have the report show histories of change requests subject
to that approver’s judgment. Or leave the box blank to list change requests that
apply to all approvers.

Request Date From: Type a beginning date for the report; any requests earlier
than that date would be excluded. Use the format configured for your instance of
Oracle. Or, leave the box blank to include requests for all dates.

Request Date To: Type an end date for the report; any requests later than that
date would be excluded. Again, use the format configured for your instance of
Oracle. Or, leave the box blank to include requests for all dates.
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Approver Performance Report

The Logical Apps AppsControl Approver Performance Report provides statistics
about the numbers of approvals, rejections, and pending decisions, as well as the time
field-value change requests have spent in the system. As you generate the report, you
can select the following parameters:

* Application: Select an application name from the list or leave the box blank. If
you select a name, the report lists only controlled fields that apply to the applica-
tion you choose. If you leave the box blank, the report lists controlled fields for
all applications.

* Approver: Select the name of a person or group with authority to approve or
reject field-value changes, and the report lists controlled fields subject to that
approver’s judgment. Or leave the box blank to list controlled fields that apply to
all approvers.

The Approver Performance report looks like this:

AppsControl Approver Performance Report

Parameters:
Application:
Approver:
Instance i wviadb
Date : 04-27-2005 16:16:10
a AppsControl Approver Performance Report
Instance i wvisdb
Date : 04-27-2005 lé:lé:l0
Paie : 2 of 2
Approver : SYSADMIN
Application Name Pending Days Approved Days Rejected Days Total Days
outstanding outstanding outstanding oucstanding
Application Object 1.00 2.10 25.00 0.68 0.00 0.00 0.74
Application Report 2.00 G.06 1l.00 o.o0 o.0o0 o.0o0 1.24
Oracle Assets 0.00 o.oo0 2z.00 0.50 0.00 0.00 0.80
Oracle Bills of Ma 0.00 o.oo0 6.00 0.00 0.00 0.00 o.oo0
Oracle General Led 5.00 7.19 5.00 o.o0 1.00 6.20 3.08
Oracle Inwventory 6.00 G.60 1l.00 0.o0 0.o0 0.00 2.33
Oracle Master 3che 0.00 o.oo0 6.00 0.00 0.00 0.00 o.oo0
Oracle Public 3ect 9.00 7.06 Z9.00 0.80 g.00 5.80 Z.63
Oracle Purchasing 0.o0 .00 5.00 1.a80 0.o0 0.00 1.60
Oracle Receiwables 7.00 6.23 0.0o0 0.00 0.00 .00 6.23
Totals: 28.00 6.66 lzo.00 0.52 7.00 5.86 1.87
Approver : EBUSINESS3-MFG
Application Name Pending Days Approved Days Rejected Days Total Days
Outstanding utstanding Outstanding futstanding
Oracle Assets 1.00 7.89 o.oo o.oo o.oo o.oo 31.59
Oracle General Led 0.00 o.oo0 0.00 0.00 0.00 0.00 o.oo0
Totals: 1.00 7.89 0.00 0.00 0.00 0.00 39.49
Grand Totals: 30.00 6.72 163.00 0.68 7.00 5.86 1.77
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Support

Logical Apps offers many services to assist you with the AppsControl implementa-
tion. From on-site support to remote phone and web support, our team of experi-
enced professionals provides the help and information you need to ensure quick and
effective implementation. The Logical Apps team includes a Technical Support Rep-
resentative, an Account Manager, and a Logical Apps staff consisting of consultants
and support specialists.

Feedback

Thank you for using LogicalApps AppsControl. We value your comments and
feedback. Mail your comments to the following address, or call us directly at (949)
453-9101.

Logical Apps

Attn.: Product Information Group
15420 Laguna Canyon Road

Suite 150

Irvine, CA 92618

US.A.

Or send email to support@logicalapps.com.
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